Fold Analysis Challenge
Sheep Mountain, Wyoming

Introduction

The Bighorn Basin area of Wyoming is well
known for interesting and well-developed
fold structures that also have economic
significance - well over 1 billions barrels of
oil have been produced from the Bighorn
Basin since the early 1900s. These fold
structures are well-exposed at the surface,
and the lack of extensive vegetation coupled
with the contrasting colors of different
lithologies makes Google Earth a fabulous
way to explore these structures in order to
achieve a better understand of fold
structures in general. At right, you'll see a
view looking SSE across the nose of the
spectacular Sheep Mountain Anticline,
which we are going to explore in this
exercise.

Getting started with Google Earth’

You will need either the Google Earth or Google Earth Pro desktop application. Google Earth for
mobile devices is not adequate - you will need to use a desktop or laptop computer. If you do
not have Google Earth on your computer, go to the free download site at
http://www.google.com/earth/download/ge/, download Google Earth, and install it on your
computer. If you already have Google Earth on your computer, make sure that it is updated to
the latest version (but be sure to back up existing placemarks before you update!).

Once you have installed (or updated) Google Earth, launch Google Earth. In the main menu bar,
go to Tools > Options (PC) or Google Earth > Preferences (Mac)

* Set the Terrain Quality slider to high and the elevation exaggeration to 1.

* Choose Decimal degrees for lat/lon, and meters/kilometers for showing elevation.

* The Options/Preferences may also have a check box called Terrain. If it does, make sure that
there is a check mark in this box.

* Click on the Navigation tab, and choose “Do not automatically tilt while zooming.”

* Go to Main Menu > View > Show Navigation > Always. Be sure that View > Status Bar
and View > Scale Legend are checked as well.

* Go to the sidebar, and expand Layers. Turn off (i.e., un-check) everything except the
Terrain box, if it'’s present. A terrain box is only present in Google Earth Pro, and you
must be sure that there is a check mark in this box, or you won’t be able to view terrain
features in 3D.

e Collapse the row of photos to hide the photo tour at the bottom of the image screen.

! If you are not already familiar with Google Earth, you can get help from: https://support.google.com/earth,
including how to navigate with the mouse and arrow keys and to change viewpoint with shift and arrow keys.




Launching the Fold Analysis Challenge

Download the Fold Analysis Challenge kmz file from http://www.geode.net/fac.kmz. Launch
Google Earth, select Open from the File menu, and select the downloaded file, fac.kmz. The file
will appear in the Temporary Places sidebar, and Google Earth will automatically zoom to the
Bighorn Basin region of Wyoming. A welcome box will also appear when you load the file. Click
the “x” to close it.
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The bedrock in this part of Wyoming consists of sedimentary strata that have been folded into
anticlines and synclines. Take some time to zoom in and explore the area by tilting and flying
through in 3D. The simplest way to do this is to put the cursor in the center of the screen, hold
down the shift key, click and hold the mouse button, and drag to tilt and rotate. Anywhere you
initially click the mouse will serve as the pivot point for tilting. Use the scroll wheel or
navigation slider to zoom in and out. You can return to a vertical view with north at the top by
pressing the R key.

You'll see that different sedimentary
layers have different properties: different
colors, different joint patterns, different
resistances to erosion, different
vegetation. You'll also see spectacular
topographic features, including flatirons
and hogback ridges.

Flatirons and hogback ridges are named
for their resemblances to an old-style iron
for ironing clothes and for the stiff ridge
that sticks up on the back of a wild boar
respectively (see pics lower right).

Once you are done exploring, double-
click again on Welcome in the side bar
to return you to a bird’s eye view of
Sheep Mountain. Close the welcome
placemark description box.




What is the Fold Analysis Challenge?

The purpose of the Fold Analysis Challenge is to help you visualize the orientations of the
eroded sedimentary layers at various places around Sheep Mountain so that you can better
visualize the shape and orientation of the fold structure responsible for the patterns that we can
see in Google Earth. After you have worked with Sheep Mountain, you will apply what you have
learned to interpret other fold structures in the Bighorn Basin. Once you have become adept at
visualizing structures, you can use the same strategies for visualizing fold structures anywhere
in the world where they are well exposed in Google Earth.

Stage 1

Determining dip. You first task will be to determine the orientation of the sedimentary layers at
two sites roughly in the middle of the Sheep Mountain structure and determine the trend of the
fold axis for that part of the fold.

* Double-click the Stage 1 folder to
zoom you in to the correct location on
Sheep Mountain.

* Inthe Google Earth sidebar, highlight
only the Site 1 placemark.

* Double-click the Site 1 placemark to
fly you to Site 1. Tilt and rotate until
you have the view shown at right.

* Highlight the radio buttons for the folders Site 1 dips and Rotate Stereographic Net,
and a stereographic net and a translucent red plane will appear.




Expand the Site 1 Dips folder, and you’ll see a series of numbers. Choose one of the values by
highlighting its radio button. Try choosing several more. What happens to the translucent red
plane in the image as you choose different values?

Now, choose a number of different values, but watch closely what happens to the stereographic
projection. You'll see that the strike remains the same but the dip changes. The steeper the dip,
the less pronounced the curvature of the great circle is on the stereographic projection.

Your job now is to find the dip value that rotates the red plane until it best matches the dip of
the layers in Google Earth. You will need to examine the clues presented by the various bedding
traces on the topographic surface. If you have a good match, the red plane will look like it
penetrates the terrain along a single stratigraphic horizon. The plane will fit best nearest to the
yellow placemark. Below, write the dip value that best fits the rock layers at Site 1.

Dip amount and direction at Site 1:

Double-click on the Site 2 placemark to take you to a bird’s eye view of the site. Tilt and rotate
until you have a view that looks obliquely NW along the line of flatirons toward Site 2.

Dip amount and direction at Site 2:

Zoom out a little, and fly around to see what you have constructed. The layers at Sites 1 and 2
clearly have very different dip directions. What happens between Site 1 and Site 2?

In the space below, sketch a schematic cross section
fromAto A’

Now go back to Google Earth. What does the fact that the
great circles for your two planes intersect in a horizontal line tell you?



If you haven’t already done so, compress the dip value folders by clicking on the down arrows.

Finding the Trend of the Fold Axis. In the previous
section, you should have reasoned out that the fact
that the two great circles intersect in a horizontal
line means that the fold axis calculated from these
two dip values is horizontal (i.e., has a plunge of
0°). To completely specify the fold axis orientation,
though, we also need the fold axis trend. If you
were doing this by hand using a stereonet, you
would determine the trend of the fold axis by
reading the azimuth at the blue arrow (right).

*  What you will do in this Google Earth
application is find this azimuth by
determining how many degrees you have
to rotate the net to bring the north pole of
the net to match the azimuth where the two
planes intersect. The diagrams at right
show two rotation steps (64° and 119°).

* Rotate N to match the fold hinge azimuth,
and write the fold plunge and trend
(properly recorded) below.

Compress the Rotate Stereographic Net folder by
clicking the arrowhead, and then compress the
Stage 1 folder.
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sedimentary layers at the NW nose of the Sheep Mountain

structure.

* Double-click on the Stage 2 folder to navigate to a

bird’s eye view of the Stage 2 area.

* Expand the Stage 2 folder, and the Plot Strike of
Beds folder. Highlight the radio button for each of
the sites but NOT for the “Set .. Strike” folders (see
right). Also highlight the Rotate Stereographic

Net folder.

* Take a few minutes to fly through the region, and

study the context of each of sites.
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* Zoom vertically in to Site 1, and highlight the radio button for Set Site 1 Strike. Zoom
and fly until you have the view shown in the image below.

Expand the Site 1 Strike folder, and you’ll see a series of numbers. Choose one of the values by
highlighting its radio button. Try choosing several more. What happens to the translucent red
plane in the image as you choose different values?

Now, choose a number of different values, but watch closely what happens to the stereographic
projection. You'll see that the dip remains the same but the strike changes (i.e., the curvature of
the great circle remains the same, but the intersection of the great circle with the periphery
changes as the strike changes). Try a plane with a strike of 137°, and then try a plane with a
strike of 317°. Go back and forth between the two values. What happens to the plane in the
imagery, and what happens to the great circle on the stereonet?

In contrast to the set-up for Stage 1, Stage 2 is designed to allow you to change the strike of the
red plane, while holding the dip constant. The two values that you explored (317 and 137) are
180° apart. Remember that we report the orientation of a plane using the right hand rule, where
the dip direction is clockwise (to the right of) the strike azimuth. So a plane with an orientation
of 137, 50 dips to the SW, whereas a plane with an orientation of 317, 50 dips to the NE.



Your job now is to find the strike value that rotates each red plane until it best matches the
strike of the layers in Google Earth. As in Stage 1, you will need to examine the clues presented
by the various bedding traces on the topographic surface. If you have a good match, the red
plane will look like it penetrates the terrain along a single stratigraphic horizon. The plane will
fit best nearest to the yellow placemark. Below, write the strike value that best fits the rock
layers at Site 1. Repeat for the other sites in the Stage 2 folder, turning each on in the side bar as
you come to it. Record strikes below.

Strike at Site 1:

Strike at Site 2:

Strike at Site 3:

Strike at Site 4:

Strike at Site 5:

Strike at Site 6:

Strike at Site 7:

As you adjust the strike of bedding at each site, the great circles on the stereonet in the upper
left corner change to reflect your estimates. If you have done a good job matching the strikes,
the great circles will all intersect on the stereographic projection in approximately the same
place. What is the significance of the orientation of the line represented in stereographic

projection by the point where all of the great circles intersect? Why don’t the great circles
intersect at the periphery as they did for the portion of the fold in Stage 1?

In the space below, sketch a schematic cross section
from B to B'.




Find the Trend of the Fold Axis by Rotating the Stereographic
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Find the Fold Axis Plunge and Trend using the Green Arrow.
You're now going to add a 3D arrow representing the fold axis.

* Expand the Set Fold Axis Plunge and Trend folder.

* Expand the various plunge folders; experiment with
different combinations of plunge and trend. Be sure to
tilt the image in Google Earth and see what changing
the fold plunge and trend does to the green arrow.

Now, go back to the previous section, and get the fold plunge
and trend that you determined from the stereonet, and select a
value close to your determined value from the options in the
sidebar. Fly around the fold. Does the green fold axis arrow
that you’'ve chosen make sense for the strikes and dips of bedding that you estimated using the
red planes? Explain.




Set the Axial Plane. The fold axis and axial plane of a fold are not independent - the fold axis is a
line within the axial plane. Start by rotating your view until you are looking directly down the
green fold axis arrow from the previous section. Be sure that your red planes are still turned on
from the first part of Stage 2.

Highlight the radio button for the folder Set Axial Plane Lean. Choose the 9 o’clock option, and
a teal-colored plane will appear. Is this a good candidate for the fold axial plane? Why or why
not?

Experiment with the other possible orientations for the axial plane. Which is the best fit option?
Justify your choice, and be sure to include what you know about the dips of bedding!

Once you have a reasonable orientation for the axial plane of your fold, add the trace of the axial
plane to your B-B’ cross section.

STAGE 3
Your next task will be to explore the overall geometry of the v ©S Stage 3
entire Sheep Mountain Anticline. ¥ ©S Cylindrical Fold Models
* Double-click the Stage 3 folder, and expand the '6% :a i‘;fiace
Cylindrical Fold Models folder. Turn on only the NW e Centrall Surface
Axis, Central Axis, and SE Axis. Leave the other items @ Central Axis
turned off. () SE Surface
* Zoom in, tilt and fly around the area, and compare the SE Axis

three fold axes shown with the green arrows. The
Central and NW fold axes are located where you worked on Stages 1 and 2 respectively
(the center and left arrows in the image below).




Estimate the trend of the SE Axis in a vertical view looking directly down on the green arrow in
Google Earth. Remember that trend is always measured in the direction of plunge. Estimate the
plunge from a low angle view looking perpendicular to the green arrow. What is the
approximate plunge and trend of the SE Axis, and how does this compare to the orientation of
the other two axes?

In the space below, sketch a schematic cross section from C to C’
across the SE end of the fold.

Is the Sheep Mountain Anticline a cylindrical fold or not? Explain, describe its geometry, and
account for the fact that all three of your cross section sketches (A-A’, B-B’, and C-C’) look
similar.

In the space below, sketch a schematic cross from D-D’ along
the length of the Sheep Mountain Anticline.

Aside from being more elongate, why does cross section D-D’
(which lies along the structure) look broadly similar to your other three cross sections (which
lie across the structure)?
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The Sheep Mountain Anticline is a doubly plunging fold, also known as a periclinal fold. The
Sheep Mountain Anticline can also be described as a whaleback anticline because it looks like
the back of a whale arching out of the water.

Now turn on the NW, Central, and SE Surfaces, also leaving the fold axes turned on and all
other items off. These red surfaces represent an approximation of the shape of the folded layers.
Each is locally cylindrical - in fact, in order to calculate a fold axis for each of the areas in Stages
1 and 2 using the stereonet, we had to assume that each small portion of the fold is, in fact,
cylindrical, even though the entire fold structure is clearly not. Tilt and fly around the area to
admire the geometry.

Now, turn off the Cylindrical Fold
Models folder and turn on the
Generalized Model. This mustard-
colored surface is a general
approximation of one of the
bedding surfaces of the Sheep
Mountain Anticline.

Zoom in, tilt, and fly around. You'll
see that the surface is only a general
approximation, because the actual
fold geometry is more complex than
this simplified rendition.

Turn off the Generalized model. Highlight the 1000 radio button, and zoom in to an oblique
view approximately like the one below.

* C(lick radio buttons with
selectively smaller numbers,
and observe what happens in
the image.

* Eachred surface is an
approximation of the shape and
location of a bedding surface at
a successively lower
stratigraphic level.

* At 1000, the bedding surface is
entirely above ground (and
therefore eroded away) except
where it would project into the
ground on the flanks of the fold.

* Asyou pick lower and lower
horizons, you'll see parts of the
red layer disappear below
ground level.

* At 300, the red surface is entirely stratigraphically below ground level.
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Fly to an oblique view approximately like the one below left, and start with the 300 surface
selected. Select selectively higher surfaces, and observe the patterns created by the intersection
of an individual bedding surface with the topography of Sheep Mountain (below right). Be sure
to fly around, zoom in, and view each from more than one vantage point.

The image above shows a view of the 475 surface. Colored arrows show “patches”, and the
colored ovals show “fingers”.

What accounts for the red patches shown by the blue arrows, and what accounts for the gray-
tan patches shown by the yellow arrows?

What accounts for the red fingers outlined by the blue oval, and what accounts for the gray-tan
fingers outlined by the yellow oval?
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Below, you'll see a published geologic map of the Sheep Mountain Anticline, and you'll see that
the geologic map also has patches and fingers. Annotate the geologic map, and indicate which
parts of the geologic map are analogous to each of the following from the previous question:
the red patches, the gray-tan patches, the red fingers, and the gray-tan fingers. Justify your
choices.

Geological map of Sheep Mountain anticline

108°12 108°10’
1 1
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108°08’
Bigh

orn River

44°38'
08°06

Thumb fold

[ Quaternary
[ Cretaceous
[ Jurassic
[[] Triassic
Permian (Phosphoria Fm)
[ Carboniferous (Pennsylvanian, Tensleep Fm)
[ Carboniferous (Pennsylvanian, Amsden Fm)
[ Carboniferous (Mississipian, Madison Fm)

—4¢— Anticlinal axis —g— Synclinal axis

Patricia Fiore Allwardt et al. Geosphere 2007;3:408-421 ©2007 by Geological Society of America

In Google Earth, go to a vertical view with N at the top, which is the same bird’s-eye view shown
in the geologic map. Try out a number of the red surfaces to find the one that most closely
matches the geologic map in terms of map pattern. Which surface did you select, and why?
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Applying what you have learned
Sheep Mountain is not the only fold in
this area. Zoom out to a vertical view
that shows roughly the same area as
shown in the image at right.

In Google Earth, zoom in and examine
the folds shown by the arrows. Are all of
them anticlines, or are some of them
synclines? How can you tell?

Add an “A” to the image at right for each
anticline and an “S” for each syncline.

Are all of the folds periclinal? Explain.

Some of the periclinal folds are fairly : L
equidimensional and are better termed 2 NS Ny X y

structural basins (if synclinal) or C ()()QIC earth
structural domes (if anticlinal). Pe A=Y

In the space below, sketch a schematic cross section from X to X'.
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Earlier in this exercise, we described the Sheep Mountain Anticline as a whaleback anticline.
One of the places in the world that has many spectacular whaleback anticlines is the Zagros
Mountains of Iran. Fly to 28.090556, 53.799540 and an eye altitude of about 400 km (view
below). Zoom out a bit so that you can see where you are in the world, then zoom back in to an
eye altitude of about 400 km.

All of the giant slugs in the view are whaleback anticlines. Zoom in, tilt, and fly around, and
explore these fabulous whalebacks. Are they indeed anticlines? How do you know? And are they
doubly plunging? How do you know?

Go back to the Sheep Mountain area, and fly to
44.687949,-108.273338 and an eye altitude of
about 12 km. You'll see the two anticlinal
structures (Goose Egg Anticline and Alkali
Anticline, labeled at right) that lie just NW of the
Sheep Mountain Anticline. Earlier in this section,
you should have determined that these are both
doubly plunging (periclinal) anticlines. Zoom in, tilt,
and fly around these anticlines. As you've seen at
Sheep Mountain and in the Zagros, whaleback
anticlines are highest topographically in the middle
of the anticline, like a giant whale’s back. Are the
Alkali and Goose Egg anticlines also whaleback
anticlines, or have the anticlinal cores been eroded?

Google gyt
C T
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This is a good lesson to learn! Not all anticlines are topographic highs - the cores of many
anticlines sit topographically lower than the resistant units that define the limbs. Such
anticlines are commonly referred to as breached anticlines.

This area of Wyoming is part of the Bighorn Basin Oil and Gas Province. Fly to 44.706209, -
108.296247 in the Goose Egg Anticline, and zoom to an eye elevation of about 1.5 km. You'll see
a set of tanks and evidence of other activity associated with petroleum extraction. In the main
menu bar, click on the clock icon to bring up historical imagery, and select the 2011 imagery.
The sun angle is a little different in this imagery, and you can actually see the shadow of a pump
jack!! Does it surprise you that they have drilled the core of an anticline and found petroleum?
Explain.

Turn off the historical imagery by clicking again on the clock icon. Fly to 44.680737, -
108.183961, and zoom to an eye altitude of about 3.0 km. You'll see more evidence of oil wells.
Zoom out a little. This is one of the folds that you looked at earlier. Have they drilled a structural
dome or a structural basin here? Does this make sense?

Wrap-up

Now that you've finished the Fold Analysis Challenge, what “Ah-ha” insights did you have with
respect to folds, fold geometries, analyzing folds, and visualizing folds? An Ah ha! insight is a
leap in insight about a particular topic - suddenly a whole bunch of things come together, the
murkiness clears, and you realize that your understanding of (or view on) a particular topic or
concept has just taken a huge leap. It's not simply a description of what you learned about. One
way to write an Ah ha” insight is to say, “I used to think that X and now I realize that Y
because...”



